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1. ВВЕДЕНИЕ 

 

Настоящее учебно-методическое пособие предназначено для магистрантов, 

обучающихся по направлению подготовки 210100 «Электроника и наноэлектро-

ника». Целью изучения дисциплины является обучение студентов общим прин-

ципам и подходам проектирования активных и пассивных микроэлектронных 

компонентов и устройств, в том числе СВЧ диапазона, с использованием совре-

менных пакетов 2D- и 3D-прикладных программ, обеспечивающих прибор-

но-технологическое проектирование нового поколения, а также интеграцию этих 

средств с САПР СБИС. Изучение и освоение типовых базовых технологических 

процессов производства микроэлектронных компонентов и устройств  с исполь-

зованием современных методов моделирования  с применением новейших про-

граммных продуктов. 

В результате изучения дисциплины обучающиеся должны: 

знать:  методы расчета, проектирования, конструирования и модернизации 

электронной компонентной базы с использованием систем автоматизированного 

проектирования и компьютерных средств; 

уметь:  разрабатывать физические и математические модели приборов и 

устройств электроники и наноэлектроники;  разрабатывать технологические 

маршруты их изготовления, при-менять новейшие технологические и конструк-

ционные материалы; 

владеть: методами проектирования электронной компонентной базы и техно-

логических процессов электроники и наноэлектроники; методами математиче-

ского моделирования технологических процессов с целью их оптимизации. 

Учебно-методическое пособие содержит методические указания по выполне-

нию практических заданий и самостоятельной работы, перечень вопросов к экза-

мену по дисциплине «Проектирование и технология электронной компонентной 

базы». 

 

  



2. РАБОЧАЯ ПРОГРАММА ПО ДИСЦИПЛИНЕ 

«ПРОЕКТИРОВАНИЕ И ТЕХНОЛОГИЯ ЭЛЕКТРОННОЙ 

КОМПОНЕНТНОЙ БАЗЫ» 

 

ЦЕЛИ И ЗАДАЧИ ДИСЦИПЛИНЫ 

 

Обучение студентов общим принципам и подходам проектирования активных 

и пассивных микроэлектронных компонентов и устройств, в том числе СВЧ диа-

пазона, с использованием современных пакетов 2D- и 3D-прикладных программ, 

обеспечивающих приборно-технологическое проектирование нового поколения, а 

также интеграцию этих средств с САПР СБИС.  Изучение и освоение типовых 

базовых технологических процессов производства микроэлектронных компонен-

тов и устройств  с использованием современных методов моделирования  с 

применением новейших программных продуктов. 

 

МЕСТО ДИСЦИПЛИНЫ В СТРУКТУРЕ ООП 

 

Дисциплина «Проектирование и технология электронной компонентной базы» 

в учебном плане находится в профессиональном цикле М2 в базовой части и яв-

ляется одной из дисциплин, формирующей общекультурные и профессиональные 

знания, навыки, характерные для магистров по направлению подготовки 210100 

«Электроника и наноэлектроника». 

 

ТРЕБОВАНИЯ К РЕЗУЛЬТАТАМ ОСВОЕНИЯ ДИСЦИПЛИНЫ 

 

Изучение дисциплины направлено на формирование у магистрантов сле-

дующих профессиональных и общекультурных компетенций (ПК): 
– способность использовать результаты освоения фундаментальных и при-

кладных дисциплин ООП магистратуры (ПК-1); 

– способностью понимать основные проблемы в своей предметной области, 

выбирать методы и средства их решения (ПК-3); 

– готовностью определять цели, осуществлять постановку задач проектирова-

ния электронных приборов, схем и устройств различного функционального 

назначения, подготавливать технические задания на выполнение проектных работ 

(ПК-8); 

– способностью проектировать устройства, приборы и системы электронной 

техники с учетом заданных требований (ПК-9); 

– способностью разрабатывать проектно-конструкторскую документацию в 

соответствии с методическими и нормативными требованиями (ПК-10); 

– способностью разрабатывать технические задания на проектирование тех-

нологических процессов производства материалов и изделий электронной техники 

(ПК-11); 

– способность использовать на практике умения и навыки в организации ис-

следовательских и проектных работ, в управлении коллективом (ОК-4); 

– способностью адаптироваться к изменяющимся условиям, переоценивать 



накопленный опыт, анализировать свои возможности (ОК-7). 

 

В результате изучения дисциплины магистрант должен: 

знать:  методы расчета, проектирования, конструирования и модернизации 

электронной компонентной базы с использованием систем автоматизированного 

проектирования и компьютерных средств; 

уметь:  разрабатывать физические и математические модели приборов и 

устройств электроники и наноэлектроники;  разрабатывать технологические 

маршруты их изготовления, применять новейшие технологические и конструк-

ционные материалы; 

владеть: методами проектирования электронной компонентной базы и тех-

нологических процессов электроники и наноэлектроники; методами математиче-

ского моделирования технологических процессов с целью их оптимизации. 

 

Содержание разделов дисциплины: 

1. Изучение современных возможностей САПР для проектирования и техно-

логии электронной компонентной базы: 

• по проектированию и моделированию приборов и интегральных схем; 

• изготовлению фотошаблонов; 

• проектированию и изготовлению печатных плат. 

2. Моделирование и  расчет характеристик активных и пассивных микро-

электронных компонентов и устройств в среде  Sentaurus TCAD: 

• трехмерное моделирование полупроводниковых субмикронных приборов, 

включающее моделирование технологического процесса формирования структуры 

прибора, механических напряжений внутри прибора и анализ трехмерного расте-

кания носителей заряда; 

• моделирование кремниевых  приборов и приборов с гетеропереходами (в 

том числе на основе SiC и GaN), приборов на основе материалов A3B5, исполь-

зующих гетеропереходы (HEMT), фотодетекторов, светоизлучающих диодов 

(LED) и полупроводниковых лазеров. 

3. Изучение базовых технологий изготовления  активных и пассивных мик-

роэлектронных компонентов и устройств,  

• в том числе сверхвысокочастотных полосковых схем, адаптированных к 

новой электронной компонентной базе сверхвысокочастотного диапазона; 

• освоение технологии новых материалов и покрытий, обеспечивающих по-

вышение надежности компонентов и интегральных схем на их основе. 

4. Одно- и двухмерное моделирование технологических процессов в среде 

SentaurusTCAD в процессе проектирования активных и пассивных микроэлек-

тронных компонентов и устройств:  

• термическое окисление кремния; 

• диффузия в кремнии при высокой и низкой концентрации примеси; 

• ионная имплантация; 

• пучковый отжиг имплантированного кремния; 

• оптическая литография; 

• литография в глубокой УФ области.  



3. ПОЛОЖЕНИЕ О РЕЙТИНГОВОЙ ТЕХНОЛОГИИ 

ОБУЧЕНИЯ 

 

Таблица 3.1. Балльные оценки для элементов контроля 

Элементы учебной деятельности 
Всего за 

семестр 

Посещение занятий 9 

Тестовый контроль 12 

Практические задания 14 

Лабораторные работы 10 

Реферат 6 

Доклад-презентация 7 

Компонент своевременности 12 

Итого максимум за период: 70 

Сдача экзамена (максимум) 30 

Нарастающим итогом 100 

 

Таблица 3.2. Пересчет баллов в оценки за контрольные точки 

Баллы на дату контрольной точки Оценка 

 90 % от максимальной суммы баллов на дату КТ 5 

От 70% до 89% от максимальной суммы баллов на дату КТ 4 

От 60% до 69% от максимальной суммы баллов на дату КТ 3 

< 60 % от максимальной суммы баллов на дату КТ 2 

 

Таблица 3.3. Пересчет суммы баллов в традиционную и международную 

оценку 

Оценка (ГОС) 

Итоговая 

сумма 

баллов 

Оценка (ECTS) 

5 (отлично) (зачтено) 90 – 100 А (отлично) 

4 (хорошо) (зачтено) 

85 – 89 В (очень хорошо) 

75 – 84 С (хорошо) 

70 – 74 
D (удовлетворительно) 

3 (удовлетворительно) (зачтено) 
65 – 69 

60 – 64 E (посредственно) 

2 (неудовлетворительно), (не за-

чтено) 
Ниже 60 

баллов 
F (неудовлетворительно) 

  



4. МЕТОДИЧЕСКИЕ УКАЗАНИЯ ПО ВЫПОЛНЕНИЮ 

ПРАКТИЧЕСКИХ ЗАДАНИЙ 

 

1. Приборно-технологическое моделирование полупроводникового ре-

зистора на подложке GaAs (Ge, Si). 

Целью работы является моделирование полупроводникового резистора на 

полупроводниковой подложке в среде Synopsys TCAD,  а также получение его 

вольт-амперной характеристики и расчет распределения напряженности электри-

ческого поля в структуре, с целью определения места, где вероятнее всего про-

изойдет пробой полупроводника.  

Краткая теоретическая часть: 

Система приборно-технологического моделирования TCAD Synopsys пред-

назначена для компьютерного моделирования технологических маршрутов изго-

товления различных полупроводниковых многомерных структур и расчета их 

электрофизических параметров и характеристик. 

Sentaurus Workbench (SWB) – графическая интерактивная управляющая 

оболочка, обеспечивающая дружественный интерфейс с пользователем  TCAD. 

SWB предназначена для организации информационного процесса внутри рабочих 

каталогов, проектов и сценариев, взаимодействия всех программных продуктов, 

объединенных в единый вычислительный поток, а также для параметризации 

входных файлов, планирования вычислительного эксперимента и статистического 

анализа полученных результатов в рамках проводимого исследования. 

Задание: 

1. Создать проект полупроводникового резистора в Sentaurus Workbench. 

 

Вариант 1 2 3 4 5 6 

Координаты 

сечения ре-

зистора 

(0,0); 

(3,2) 

(0,0); 

(3,2) 

(0,0); 

(3,2) 

(0,0); 

(3,2) 

(0,0); 

(3,2) 

(0,0); 

(3,2) 

Подложка GaAs GaAs Si Si Ge Ge 



Координаты 

сечения ка-

нала резисто-

ра 

(0,0); 

(3,0.1) 

(0,0); 

(3,0.2) 

(0,0); 

(3,0.1) 

(0,0); 

(3,0.2) 

(0,0); 

(3,0.1) 

(0,0); 

(3,0.1) 

Концентрация 

фонового ле-

гирования 

резистора 

10
14

 2*10
14

 10
14

 2*10
14

 10
14

 2*10
14

 

Концентрация 

легирования 

канала 

3.5*10
17

 7*10
17

 3.5*10
17

 7*10
17

 3.5*10
17

 7*10
17

 

Концентрация 

легирования 

омических 

контактов 

10
19

 10
19

 10
19

 10
19

 10
19

 10
19

 

Координаты 

вершин кон-

тактов source 

и drain: 

(0.5,0); 

(2.5,0) 

(0.5,0); 

(2.5,0) 

(0.5,0); 

(2.5,0) 

(0.5,0); 

(2.5,0) 

(0.5,0); 

(2.5,0) 

(0.5,0); 

(2.5,0) 

 

2. Сделать скриншоты ВАХ резистора и графиков полученных в Tecplot SV; 

3. Проанализировать полученный прибор в модулях Inspect и Tecplot SV, 

ответить на контрольные вопросы. 

4. Результатом работы является отчет. 

    Отчет должен содержать: 

–  краткую теоретическую часть; 

–  параметры проектируемого устройства согласно варианту; 

–  ход работы; 



– скриншоты ВАХ и график распределения напряженности электрического 

поля в структуре; 

– указать место, где вероятнее всего произойдет пробой полупроводника; 

–  ответы на контрольные вопросы. 

 

Ход работы:  

1. Открыть модуль Sentaurus Workbench.  

2. Создать новый проект в дереве проектов и сохраните его (Project > New Pro-

ject).  

 

Рисунок А.1 – рабочее окно Sentaurus Workbench 

3. Добавить в рабочее пространство инструмент Mesh.  



 

Рисунок А.2 – выбор инструмента в рабочее окно SWB 

4. Правой кнопкой мыши по появившемуся инструменту Mesh. (Edit input > 

Boundary) для появления окна программного модуля Sentaurus Structure Edi-

tor.  

 

Рисунок А.3 – рабочее окно Sentarus Structur Editor 



5. На правой вспомогательной панели выбрать «Exact coordinates» для точного 

задания координат сечения резистора. 

6. На панели инструментов выбрать материал подложки. 

7.  На панели инструментов выбрать «Create rectangular sheet region» для 

создания прямоугольной области, которая будет являться сечением резистора 

в плоскости (X -Y) в которой будет производиться моделирование. 

 

Рисунок А.4 – создание сечения резистора 

8. Задать координаты сечения резистора (x1,y1);(x2,y2).  

 

Рисунок А.5 – координаты сечения резистора 

9. После создания основной области выделить области канала и омических 

контактов. Для этого выбрать пункт меню Mesh > Define Ref/Eval Window > 

Rectangle и задать прямоугольную область (область канала) с углами в 

точках, например, (0,0) и (3,0.1). 

 



 

Рисунок А.6 – координаты сечения канала резистора 

 

 Для задания областей омических контактов создать прямоугольные области 

с координатами (0,0);(0.5,0.3) и (2.5,0);(3,0.3).  

  

Рисунок А.7 – координаты сечения областей омических контактов 

резистора 



 

Рисунок А.8 – геометрическая структура резистора в окне SSE 

 

10.  Создать профиль фонового легирования структуры. (Device > Constant Pro-

file Placement). В секции Placement Type выбрать Region > region_1, в секции 

Constant Profile Definition задать имя (Name) Background и концентрацию 

(Concentration) 1e14, в поле Species нужно оставить BoronActiveConcentration, 

так как заданная примесь имеет p-тип легирования. Нажать Add Placement для 

создания профиля фонового легирования структуры.  



 

Рисунок А.9 – задание параметров фонового легирования структуры 

 

11.  Создать профиль легирования канала. Для этого изменить в секции Place-

ment Name имя профиля на ConstantProfilePlacement_2, выбрать в секции 

Placement Type вариант Ref/Eval Window, указав в правой секции 

RefEvalWin_1 (область канала). В секции Constant Profile Definition задать 

имя Channel (канал). В качестве легирующей примеси (Species) выбрать 

примесь n-типа ArsenicActiveConcentration и уровень легирования 3.5e17. Add 

Placement.  



 

Рисунок А.10 – задание параметров легирования канала 

 

12.  Создать профили легирования омических контактов. Создать профили с 

именами ConstantProfilePlacement_3, ConstantProfilePlacement_4 для областей 

омических контактов RefEvalWin_2 и RefEvalWin_3 соответственно с 

названиями Contact1 и Contact2 для секции Constant Profile Definition. В 

качестве легирующей примеси выбрать ArsenicActiveConcentration (для 

получения n+) и уровни легирования 1e19. Add Placement. 

 



 

Рисунок А.11 – задание параметров легирования омического контакта 1 

 



 

Рисунок А.12 – задание параметров легирования омического контакта 2 

 

13.  Задать параметры генерации сетки в области полуизолирующего буферного 

слоя в редакторе сетки Mesh > Refinement Placement. Задать имя создаваемой 

сетки (Placement Name), задать область в которой сетка будет расположена – 

region_1 (Placement Type). Ввести размеры максимального и минимального 

элемента сетки в каждом направлении (Max Element Size и Min Element Size) 

– 0.05. Завершить создание нажатием Add Placement.  



 

Рисунок А.13 – задание параметров генерации сетки в области 

полуизолирующего буферного слоя 

 

14.  Задать параметры генерации сетки в области канала (RefEvalWin_1).  Max 

Element Size и Min Element Size – 0.05. В секции Refinement Functions 

выставить значение шага сетки (Value) 0.01.  



 

Рисунок А.14 – задание параметров генерации сетки в области канала 

 

15.  Задать контактные области.  

 

Рисунок А.15 – кнопка Add Vertex на панели инструментов 

 

Обозначить размеры контактных областей. Добавить две вершины (кнопка 

Add Vertex на панели инструментов) с координатами (0.5,0) и (2.5,0). 



     

Рисунок А.16 – задание вершин контактных областей 

 

В окне Contacts > Contacts Sets ввести имя контакта (Contact Name) source. 

Нажать Set, затем выбрать в левом окне созданный контакт и активировать его 

(Activate).  

 

Рисунок А.17 – активация контактов 

 

Выбрать правым щелчком контакт 1 (исток), установить уровень 

выделения Selection Level > Edge для задания местоположения контакта.  



 

Рисунок А.18 – установка уровня выделения Selection Level > Edge 

 

Выбрать щелчком область истока (0.5,0). После выбора область 

выделится оранжевым цветом. 

 

Рисунок А.19 – Выбор области истока 



 

 

Задать выбранный контакт Contacts > Set Contact (при успешном 

выполнении контакт сменит цвет на красный). 

 

Рисунок А.20 – Задание выбранного контакта 

 

 

Contact > Contacts Sets. Имя контакта – drain. Активировать контакт. 

Выбрать щелчком область стока (2.5,0). Задать выбранный контакт Contacts > 

Set Contact.  



 

Рисунок А.21 – готовая графическая структура резистора 

 

16. Сохранить структуру.  

File > Save model as.. Имя сохраняемого файла: mesh_msh.cmd.  

File > Save Boundary as.. Имя сохраняемого файла: mesh_msh.bnd. 

При сохранении файлов с другим именем, необходимо правым щелчком по 

инструменту mesh открыть свойства (properties). Затем во вкладке input files 

переименовать файлы в соответствии с сохраненными файлами. 



 

Рисунок А.22 – сохранение проекта 

 

17.  Вернуться в Sentaurus Workbench. Сохранить проект Project > Save as> pro-

ject… Имя сохраняемого файла: lab1.  Запустить узел проекта (Run)(с по-

мощью кнопки на панели инструментов, либо правый щелчок по узлу mesh). 

 

Рисунок А.23 – запуск проекта 

 

18.  При успешном выполнении узел окрасится в желтый цвет (done). Неудачное 

выполнение – узел окрасится в красный цвет (failed). 

19. Добавьте программный модуль sdevice, щелкните на добавленный значок 

правой кнопкой мыши и выберите Edit Input > Commands... Так как писать ко-



мандный файл с нуля достаточно долго, рекомендуется использовать шаблон, из-

меняя который, можно добиться требуемых результатов. В качестве шаблона 

можно использовать, например, такой файл:  

File {  

Grid = ”@grid@”  

Doping=”@doping@”  

Plot = ”@dat@”  

Current = ”@plot@”  

Output = ”@log@”  

}  

Electrode {  

{ Name=”source” Voltage=0.0 }  

{ Name=”drain” Voltage=0.0}  

{ Name=”gate” Voltage=0.0 Barrier=-0.55 }  

}  

Physics {  

Mobility (DopingDependence HighFieldSat Enormal)  

EffectiveIntrinsicDensity (BandGapNarrowing (OldSlotboom))  

}  

Plot {  

eDensity hDensity eCurrent hCurrent  

Potential SpaceCharge ElectricField  

eMobility hMobility eVelocity hVelocity  

Doping DonorConcentration AcceptorConcentration  

}  

Math {  

Extrapolate  

RelErrControl  

}  

Solve {  

#-initial solution:  

Poisson  

Coupled { Poisson Electron }  

#-ramp gate:  

Quasistationary (  

Goal{ Name=”gate” Voltage=2 } )  

{ Coupled { Poisson Electron } }  

} 

Секцию File оставим без изменений, так как в качестве имен входных и вы-

ходных файлов указаны названия переменных. SWB сам подставит нужные имена 

при процедуре предварительной обработки.  

В секции Electrode необходимо убрать отсутствующий в структуре электрод с 

именем gate. Так как при создании структуры нами были использованы имена 

электродов source и drain, то две первые строчки останутся без изменений. Ито-

говая секция Electrode будет выглядеть следующим образом:  

 
Electrode {  
{ Name=”source” Voltage=0.0 }  
{ Name=”drain” Voltage=0.0}  
}  
 

Для максимального упрощения физической секции ограничимся моделью по-

движности, зависящей от температуры и концентрации легирующей примеси в 

полупроводнике (DopingDependence), а также моделью насыщения скорости 



электронов в сильных электрических полях (HihgFieldSaturation). После включе-

ния данных моделей секция примет вид  

 
Physics {  
Mobility (DopingDependence HighFieldSaturation)  
}  
 

Секции Plot и Math оставим без изменений.  

В секцию Solve необходимо внести следующие изменения. Так как целью моде-

лирования является получение зависимости тока стока от напряжения на стоке, то 

необходимо изменить имя электрода, на который будет подаваться напряжение. 

Изменив имя gate на drain и увеличив напряжение до 5 В, получим:  

 
Solve {  
#-initial solution:  
Poisson  
Coupled { Poisson Electron }  
Quasistationary (  
Goal{ Name=”drain” Voltage=5 } )  
{ Coupled { Poisson Electron } }  
}  

Важно! Кавычки должны иметь вид “”, кавычки вида  «» программой не 

читаются! 
 

Командный файл готов. Сохраните его и cохраните проект.  

20. Запустите процесс моделирования. Если все было сделано правильно, то 

после завершения расчета соответствующий узел проекта станет желтого 

цвета. 

21. Правой кнопкой мыши по последнему узлу > Visualize > *.plt 

 



Рисунок А.24 – Команда Visualize 

 

 22. Выберите drain, затем OuterVoltage и нажмите To X-Axis. 

 

Рисунок А.25 – Выбор оси X 

23. Выберите TotalCurrent и нажмите To Left Y-Axis. 



 

Рисунок А.26 – Выбор оси Y 

 

 24. Изучите полученный график. 



 

Рисунок А.25 – График зависимости drain(TotalCurrent) от drain(OuterVoltage) 

25. Чтобы отобразить распределение напряженности электрического поля по 

структуре, щелкните правой кнопкой мыши на узле и выберите пункт 

Visualize > Tecplot SV(Select file…). Выберите файл с расширением .dat. 

 

Рисунок А.26 – Команда Visualize > Tecplot SV(Select file…). 



 

26. В открывшемся окне выберите переменную с именем ElectricField. 

 

Рисунок А.27 – Напряженность электрического поля по структуре 

 

27.  Изучите полученный рисунок. 

 

Контрольные вопросы: 

1. Дайте понятие проекта в  SWB и объясните, каким образом его можно 

создать (скопировать), запустить на расчет, остановить вычисления и 

удалить результаты расчета. 

2. Поясните, каким образом в  SWB можно задать вычислительный поток 

из нужных приложений? 

3. В чем суть понятия узла проекта? 

4. Как добавить инструмент в рабочую область Sentaurus Workbench? 

5. Поясните, что дает фоновое легирование структуры бором? 



6. Какая область резистора обозначалась как region_1? 

7. Зачем в структуре генерируется сетка? 

8. Как запустить проект на выполнение? 

 

  



2. Приборно-технологическое моделирование диода Шоттки. 

Целью работы является моделирование диода Шоттки в среде Synopsys 

TCAD,  а также получение его прямой и обратной ветвей вольт-амперной харак-

теристики в Inspect и получение графиков структуры в Tecplot SV.  

Краткая теоретическая часть: 

Sentaurus Device — это  программный модуль для  моделирования элек-

трических, термических и оптических характеристик кремниевых и сложных по-

лупроводниковых приборов. Он позволяет моделировать работу широкого спек-

тра полупроводниковых устройств, включая наноразмерные КМОП-транзисторы, 

FinFET, КМОП-датчики изображения, флэш-память, крупные мощные транзи-

сторы, SiGe-биполярные гетеротранзисторы, аналоговые/высокочастотные тран-

зисторы, светоизлучающие диоды, лазеры. 

Sentaurus Device является разносторонним модулем для моделирования  

полупроводниковых устройств, обеспечивающим эмуляцию электрических, тем-

пературных и оптических характеристик кремниевых и гетероструктурных при-

боров. Он позволяет работать с одно-, двух-трехмерными моделями в различных 

условиях функционирования устройства. Кроме того, Sentaurus Device делает 

возможным анализ и оптимизацию электростатического разряда (ESD), единич-

ного случайного сбоя (SEU) и кратковременной ошибки. 

 Задание: 

1. В работе №2 все варианты выполняют одинаковое редактирование своих про-

ектов, полученных в работе №1. 

2. Результатом работы является проект диода Шоттки на подложках из арсенида 

галлия (1,2 вариант), кремния (3,4 вариант) и германия (5,6). 

3. Создайте проект в Sentaurus Workbench, отредактировав проект, получившийся 

в итоге первой лабораторной работы; 

 контакт gate с координатами (1.25,0) и (1.75,0); 

 отредактировать файл Sentaurus Device (секции Electrode и Solve); 

 значения для Schottky Barrier=0.7; 



 задать шаг напряжения на затворе 0.02 В; 

 задать переменную конечного напряжения @Vg@ в проекте SWB; 

 в окне добавления переменной задать параметры Default Value= -1, Min. 

Value= -1, Step=2, Number of Values=2. 

4. Проанализировать полученный прибор в модулях Inspect и Tecplot SV, ответить 

на контрольные вопросы. 

5. Результатом работы является отчет, в котором должны быть отражены краткая 

теоретическая часть, ход работы, ответы на контрольные вопросы и отображены 

ВАХ и необходимые расчеты структур. 

Ход работы:  

1. Открыть модуль Sentaurus Workbench.  

2. Открыть проект «lab 1.tmp», созданный в лабораторной №1, в дереве проектов и 

сделаем копирование проекта. (на открытом проекте lab1.tmp в меня Project-> 

Save as->Project и зададим имя lab2). 

3. Запустить Sentaurus Structure Editor для редактирования файла mesh_msh.bnd. 

(правой кнопкой мыши по значку Mesh > Edit input > Boundary, рис. Б.1)  



 

Рисунок Б.1- Sentaurus Structure Editor 

 

4. Загрузить параметры границ. File > Import> mesh_msh.sat (Рис.Б.2) 

 

Рисунок Б.2 – Структура резистора с загруженными границами 

5. Задать контактные области (рисунок Б.3) 



 

Рисунок Б.3 – Добавление вершин контактных областей. 

Обозначить размеры контактных областей. Добавить две вершины 

(кнопка Add Vertex на панели инструментов) с координатами (1.25,0) и (1.75,0) – 

Рис.Б4.  

  

Рисунок Б.4 – Задание размеров контактных областей 

 

В окне Contacts > Contacts Sets ввести имя контакта (Contact Name) gate. 

Нажать Set, затем выбрать в левом окне созданный контакт и активировать его 

(Activate).В результате получим контакт (Рис. Б.5): 

 

Рисунок Б.5 – Добавление контакта Gate 



Вообще, у диода, как такового нет контакта Gate, но так как мы проек-

тируем по физическому принципу полевой транзистор, работающий в диодном 

включении (об этом далее), поэтому и создаем этот контакт затвора. На таком 

принципе работает вся современная компьютерная электроника. 

6. Установить уровень выделения Selection Level > Edge на панели инструментов 

для задания местоположения контакта(Рис. Б.6).  

 

Рисунок Б.6 - Уровень выделения Selection Level > Edge 

 

Выбрать выделением область затвора gate (1.25,1.75). После выбора область 

выделится оранжевым цветом. (Рис. Б.7 - Обратите внимание, какой инструмент 

выделения выбран (выделен желтым цветом)). 

 

Рисунок Б.7 – Выделение области затвора 

 Задать выбранный контакт Contacts > Set Contact (при успешном 

выполнении контакт сменит цвет на красный, см. рис. Б.8).  



 

Рисунок Б.8 – Контакт Gate задан 

Если не получилось, зайти в окно Contacts > Contacts Sets, выбрать контакт 

Gate, щелкнуть по кнопке «Activate», и повторить процедуру выделения, задания 

контакта. 

7. Сохранить структуру.  

File > Save Model без каких-либо разрешений. Программа сама сохранит все 

нужные нам форматы для работы. 

     Так же сохранить File > Save Boundary. 

 

8. Вернуться в Sentaurus Workbench. Запустить узел проекта (Run), рис. Б.9. 

 

Рисунок Б.9 – запуск узлов проекта 

9.  При успешном выполнении узел окрасится в желтый цвет (done). Неудачное 

выполнение – узел окрасится в красный цвет (failed). 

10.  Открыть для редактирования командный файл Sentaurus Device. Правой 

кнопкой мыши по значку SDevice > Edit input > Commands. 



11. Отредактировать секцию Electrode, добавив описание затвора и параметра 

Schottky Barrier. 

Electrode {  

  { Name=”source”  Voltage=0.0 }  

  { Name=”drain” Voltage=0.0}  

  { Name=”gate” Voltage=0.0 Schottky Barrier=0.7 }  

  }   

12. Отредактировать секцию Solve, добавив описание переменной конечного 

напряжения @Vg@. Задать максимальный шаг напряжения MaxStep 0.02 В. 

Solve {  

 #-initial solution:  

      Poisson  

      Coupled { Poisson Electron }  

Quasistationary ( MaxStep=0.02  

      Goal{ Name=”gate” Voltage=@Vg@ } )  

  { Coupled { Poisson Electron } }  

} 

13.  Сохраните командный файл и вернитесь в окно проекта Sentaurus Workbench. 

14.  Добавить переменную конечного напряжения @Vg@.  Контекстное меню под 

инструментом SDevice > Add (Рис.Б.10). 

 



 

Рисунок Б.10 – контекстное меню под SDevice 

 В строке Parameter – имя переменной Vg; в строке Default Value – значение по 

умолчанию (максимальный уровень обратного напряжения (в вольтах), которое 

будет подаваться на диод (-1В)) (Рис.Б.11). 

 

Рисунок Б.11 – Задание переменной Vg 

15.  Задать параметры для переменной Vg. Правой кнопкой мыши по переменной в 

окне SWB, далее Add Values. (Рис. Б.12). 

 



 

Рисунок Б.12 – Контекстное меню Add Values 

 

 Параметры задать в соответствии с вариантом (Рис. Б.13). 



 

Рисунок Б.13 – Задание параметров переменной Vg 

16.  Запустите расчет, и получите графики прямой и обратной ветвей 

вольт-амперной характеристики (Рисунок Б.15) в Inspect (для контакта Gate) и 

графики структуры в Tecplot SV. (Рисунок Б.14, Б.16, Б17). 

 



Рисунок Б.14 – Контекстное меню вызова модуля Tecplot 

 

Рисунок Б.15 – Соответственно, обратная и прямая ветви ВАХ диода 

Как  видно  из  графика,  при  подаче  отрицательного смещения  через  

диод  протекает небольшой  обратный  ток  (ток имеет  знак  минус). 



 

Рисунок Б.16 – eDensity(электронная плотность) для прямого включения 

диода 



 

Рисунок Б.17 - eDensity(электронная полтность) для обратного включения диода 

17.  При неудачном выполнении расчета (узел загорится красным цветом) – найти 

ошибку. (Если загвоздка будет в сохранении файлов, и при компиляции, про-

грамма выдаст сообщение об ошибке «Tried to use non-existing contact “gate”» в 

логе ошибок, попробуйте создать проект заново, с первой лабораторной, без 

сохранения, и сразу создав три контакта). 

18.  Ответьте на контрольные вопросы. 

Контрольные вопросы: 

1. Для чего используется Sentaurus Device? 

2. Что такое командный файл Sentaurus Device? 

3. Какими двумя способами создается структура в приборе в Synopsys 

TCAD? 

4. За что отвечает секция Electrode командного файла SDevice? 

5. За что отвечает секция Solve командного файла SDevice? 

6. Каков статус узла, если он окрашен в красный цвет? 

7. Проанализируйте график обратной и прямой ВАХ диода. 

 

  



5. МЕТОДИЧЕСКИЕ УКАЗАНИЯ ПО ВЫПОЛНЕНИЮ 

САМОСТОЯТЕЛЬНОЙ РАБОТЫ 

 

Перечень тем для самостоятельного изучения 

1. Изучение современных возможностей САПР по проектированию и модели-

рованию приборов и интегральных схем 

2. Изучение современных возможностей САПР по изготовлению фотошаблонов 

3. Изучение современных возможностей САПР по проектированию и изготов-

лению печатных плат 

4. Моделирование технологического процесса формирования структуры при-

бора 

5. Моделирование механических напряжений внутри прибора 

6. Моделирование и анализ трехмерного растекания носителей заряда 

7. Моделирование кремниевых  приборов и приборов с гетеропереходами (в 

том числе на основе SiC и GaN) 

8. Моделирование приборов на основе материалов A3B5, использующих гете-

ропереходы (HEMT) 

9. Моделирование фотодетекторов, светоизлучающих диодов (LED) и полу-

проводниковых лазеров 

10. Изучение базовых технологий изготовления сверхвысокочастотных полос-

ковых схем, адаптированных к новой электронной компонентной базе 

сверхвысокочастотного диапазона 

11. Освоение технологии новых материалов и покрытий, обеспечивающих по-

вышение надежности компонентов и интегральных схем на их основе 

12. Одно- и двухмерное моделирование термического окисления кремния 

13. Одно- и двухмерное моделирование диффузии в кремнии при высокой и 

низкой концентрации примеси 

14. Одно- и двухмерное моделирование ионной имплантации 

15. Одно- и двухмерное моделирование пучкового отжига имплантированного 

кремния 

16. Одно- и двухмерное моделирование оптической литографии 

17. Одно- и двухмерное моделирование литография в глубокой УФ области 

 

Студент должен выбрать одну из перечисленных тем для углубленного изу-

чения, по итогам которого должен быть написан реферат и сделан доклад на 

практическом занятии. 

  



6. ВАРИАНТЫ ВОПРОСОВ К ЭКЗАМЕНУ 

 

1. Современные возможности САПР по проектированию и моделированию при-

боров и интегральных схем 

2. Современные возможности САПР по изготовлению фотошаблонов 

3. Современных возможности САПР по проектированию и изготовлению печат-

ных плат 

4. Моделирование технологического процесса формирования структуры прибора 

5. Моделирование механических напряжений внутри прибора 

6. Моделирование и анализ трехмерного растекания носителей заряда 

7. Моделирование кремниевых  приборов и приборов с гетеропереходами (в том 

числе на основе SiC и GaN) 

8. Моделирование приборов на основе материалов A3B5, использующих гетеро-

переходы (HEMT) 

9. Моделирование фотодетекторов, светоизлучающих диодов (LED) и полупро-

водниковых лазеров 

10. Базовые технологии изготовления сверхвысокочастотных полосковых схем, 

адаптированных к новой электронной компонентной базе сверхвысокочастот-

ного диапазона 

11. Технологии новых материалов и покрытий, обеспечивающих повышение 

надежности компонентов и интегральных схем на их основе 

12. Одно- и двухмерное моделирование термического окисления кремния 

13. Одно- и двухмерное моделирование диффузии в кремнии при высокой и низ-

кой концентрации примеси 

14. Одно- и двухмерное моделирование ионной имплантации 

15. Одно- и двухмерное моделирование пучкового отжига имплантированного 

кремния 

16. Одно- и двухмерное моделирование оптической литографии 

17. Одно- и двухмерное моделирование литография в глубокой УФ области 
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